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Copyright 
 
 
 

Copyright 
 
©2002 Premier Assistive Technology, Inc..  All Rights Reserved.  This documentation and the 
accompanying software are copyrighted materials.  Making unauthorized copies of this material is 
prohibited by law.  No part of the software or documentation may be reproduced, transmitted, 
transcribed, stored in a retrieval system or translated into any human or computer language 
without prior written permission of Premier Assistive Technology, Inc..  Premier Assistive 
Technology, Inc. asserts its "Moral Right" to be identified as the author of this work, in all 
jurisdictions which recognize the "Moral Right." 

 

Notice 
 

UNLESS OTHERWISE PROVIDED BY WRITTEN AGREEMENT WITH PREMIER 
ASSISTIVE TECHNOLOGY, INC.,  THIS PUBLICATION, AND THE SOFTWARE SOLD 
WITH THIS PUBLICATION ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY 
KIND EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT THIS PARTICULAR 
PURPOSE.  THE ENTIRE RISK ARISING OUT OF THE USE OR PERFORMANCE OF THIS 
PUBLICATION AND SOFTWARE REMAINS WITH YOU, THE USER.  IN NO EVENT 
SHALL PREMIER ASSISTIVE TECHNOLOGY, INC., OR ANY OF ITS SUPPLIERS, BE 
LIABLE FOR ANY LOST PROFITS, LOSTSAVINGS, DIRECT, INCIDENTAL OR 
INDIRECT DAMAGES OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES, EVEN 
IF PREMIER ASSISTIVE TECHNOLOGY, INC., OR ITS SUPPLIERS, HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  PREMIER ASSISTIVE 
TECHNOLOGY, INC. RESERVES THE RIGHT TO MODIFY THIS DOCUMENT AT ANY 
TIME WITHOUT OBLIGATION TO NOTIFY ANYONE. IN NO EVENT SHALL PREMIER 
ASSISTIVE TECHNOLOGY, INC. OR ITS SUPPLIERS’ LIABILITY UNDER THIS 
AGREEMENT EXCEED THE SUM OF ANY AMOUNTS PAID HEREUNDER BY THE 
CUSTOMER TO PREMIER ASSISTIVE TECHNOLOGY, INC. OR THE SUPPLIER. 

 
 
Trademarks 
 

These other marks include, but are not necessarily limited to: WINDOWS, WINDOWS 95, 
WINDOWS 98, WINDOWS NT, and WINDOWS 2000, Windows Me, Window XP, Windows 
Vista which are registered Trademarks of Microsoft Corporation.  WinZip is a registered 
trademark of WinZip Computing, Inc.   PKZIP is a is a registered trademark of PKWARE, Inc.    

 
You shall not use any of the Trademarks, or Service marks of Premier Assistive Technology, Inc., 
or Microsoft Corporation, or any other entity, without the express written permission of such 
Trademark or Service mark owner. 
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Deletion or Modification 

 
If any portion of this Manual, including but not limited to the "Notice" section 
above, is held to be unenforceable, then that portion shall be deleted, and the 
remaining language shall be given its broadest legal effect. 

 
 
Premier Assistive Technology, Inc. 
1309 N. William St. 
Joliet, IL  60435 
Phone: 815-927-7290 Fax: 815-722-8802 
 
E-mail: info@readingmadeeasy.com  
Web: www.readingmadeeasy.com 
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About Scan and Read Professional 
 

Scan and Read is a reading package that bridges the gap between the physical 
world and the electronic world.  Scan and Read will allow you to read virtually 
any printed material.   It will take documents placed on the scanner or from your 
computer, open them up and read them to you.  It highlights a word as it reads to 
you, allowing you follow along both visually and while you listen.  The voice and 
reading speed (rate) are adjustable, so it can be fine tuned to your liking. 
 
Scan and Read is primarily a reading package, but it can also be used as a word 
processor.  You can highlight, edit, cut, copy and paste into it.   Scan and Read 
allows you to read continuously from beginning to end of a document or, if you 
want, you can read one word at a time, or even spell a word out by reading a 
character at a time. 

 

How does it Work?   
 

Scan and Read is known for it’s easy-to-use interface.  How does it work?  
Simply place some printed material on the scanner and press the F5 key or click 

on the scanner icon. .  The scanner will take a picture of what you have 
placed on the scanner and bring it into the computer.  Once the picture is in the 
computer, Scan and Read will determine the position you placed the paper on the 
scanner.  Scan and Read does not care how positioned the document when you 
placed it on a document on a scanner.   You can place it sideways, upside down or 
even crooked and Scan and Read will figure it out.   

 
Once Scan and Read has determined how you have placed it on the scanner, it 
will now grab the text from the scanned image.  This is called OCR or “Optical 
Character Recognition”.   Now Scan and Read will place the text it collected into 
the view area of the screen.  This area is a word processor and you can perform 
full word processing on the text once it is in this window. 
 
Scan and Read will tell you once it’s done scanning.  When you hear “Document 
Done” you will know that you can start reading now.  To do this press, the F6 key 

or click on the read icon. .  Scan and Read will continue to read until you 
tell it to stop. You do this by pressing the F7 key or clicking on the stop icon. 
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.  Once you have adjusted the settings for the program to your particular 
preferences, in the future, the only thing you have to do is press the F5 key to 
scan, F6 key to read and the F7 to stop reading (or press the corresponding icons / 
buttons for those functions).  That is all you have to do.  You will be up and 
running with Scan and Read in just a few minutes.  

 
It is important to note that Scan and Read will work with any USB scanner. 
Effectively, Scan and Read will work with any new scanner built today.  It also 
works with the new multi-function “all in one” units.  The current trend for printer 
manufacturers is to build units that can copy, scan, fax and print.  Scan and Read 
will work with these as well. 

Scan and Read Pro - The Program 
 

Scan and Read has a very simple easy-to-use interface.  The tool bar contains 
large icons with pictures and captions.  The editing or formatting bar contains 
icons that are standard and customarily used in the industry.  
 

 

 

Tool Bars 

Menu 

Status Bar Reading Area 
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Installing Scan And Read Pro 

Windows XP Home and XP Professional, Vista 
 

The installation of Scan and Read will take about 5 minutes for today’s average 
PC. To install Scan and Read, you will need the minimum system requirements. 
Refer to “See System Requirements” in this section of the manual. To install Scan 
and Read, follow these steps. 

 
1. Place your CD in the CD ROM drive. 
2. The CD is “auto loading”, so a setup screen should automatically be 

displayed.  If this screen does not display, go to your CD ROM drive and run 
program call “SETUP.EXE”.  The setup program will prompt you for input 
several times during the install process depending on your operating system. 

3. Scan and Read will create a program group call “Scan and Read Pro” which 
will be located in your program list.  

 

System Requirements 
 

CPU:   900 MHz Pentium or Faster 
Memory:  256 MB   
Disk space:      400 MB  
CD ROM:  4X or Faster 
Keyboard:   104-key Standard Keyboard 
Mouse:  Standard Mouse 
Speakers:  Standard Speakers 
Sound Card:   Any Windows Compatible Sound card 
Scanner: Any TWAIN compliant, USB compatible scanner 
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Short Cut Key List 
 

To Scan     Press the F5 Key 
To Read     Press the F6 Key 
To Stop Reading    Press the F7 Key 
To Read Selected Text Only  Press the F8 Key 
To Change Voices    Press the F12 Key 
To Read the Next Word  Press CTRL + the Right Arrow  
To Read the Previous Word  Press CTRL + the Left Arrow  
To Read One Line at a time  Press the Up or Down Arrows 
To Spell out a word   Press the Left or Right Arrow 
To Create a New Document  Press CTRL+N 
To Open a Document   Press CTRL+O 
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File Menu 
 
Under the file menu you will see a list of menu options that are used to manipulate files 
under this menu you will see menu options new, open, save and print a document. You 
will also find a way to close Scan and Read. 
 

New Document 
 

To create a new document, press CTRL + N or go to the File menu and select 
New.  New will clear the screen of any text.  If you want to save the information 
on the screen, you must save the information prior to selecting New.  You must 
“scan” or “open” to bring in a new document. 
 
 

Opening a Document 
 

There are two types of documents that you can open.  It depends on which view 
you are in.  If you are in the Image view, the system will prompt you to open an 
image. If you are in the word processing view, you will be able to open a word 
processing document.  See Switching View for more detail about changing 
between image and word processing views. 

 
Opening a document: To open a document, press CTRL+O, or click on the Open 

button.   The Open Dialog Box will appear. 
 

 

Select A 
File Type 
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The dialog box functions the same as any Microsoft Windows Dialog Box. You 
can select where you want to look, or select the file type or file name.  Scan & 
Read can save in the following formats:  Microsoft Word 97, Standard Text Files, 
HTML Documents, and Rich Text Format. 
 
Once you have found the file that you want to open, press the Enter key.  The 
document will be opened and displayed in the word processing window.   

 

Saving a Document 
 

There are two ways to save a document, you can use Save and Save As.  If you 
have opened an existing document you can use the Save feature.  You will not be 
prompted for a file name.  If you have not given the document a name yet, when 
you try to save the file, it will prompt you for a file name and type. 
 
To save an existing document, press CTRL+ S, select Save from file menu, or 

click on the save button .  If you select save from the file menu or if you 
click on the save button the Save dialog box will open 
 

 

Give the 
document a 

name and select 
t

 
 If you want to save the document as a different name or different file type, select 
the Save As feature.  Once the Save As dialog box opens, enter a new file name or 
select a different file type. 

 

Printing 
 

The printing feature only works with the word processor.  To print a document, 
press CTRL+P.  It will print the document, which is opened in the word processor 
window.   
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For mouse users: select the File menu by clicking on it with you’re left mouse 
button and then select Print from the dropdown list with your left button. 

 

Exit 
 

There are two ways to exit the application. The easiest way is to press ALT+F4.  
This will close the application.  If the information displayed on the screen has not 
been saved first, it will be lost.  You can also exit the application by selecting the 
file menu and then select Exit from the menu. 

 
 

Edit Menu 
 

The Edit menu only effects the word processor view.  The edit menu provides you 
with common word processing tools. It allows you to cut, copy, or paste text 
within the word processing window or search for a specific word.  
 
Cut: To cut text from the word processor, select / highlight the desired text you 
want to cut and then select Cut from the edit menu.  You can also use the standard 
window command of CTRL+X. 
 
Copy: To copy text from the word processor, select / highlight the desired text 
you want to copy and then select Copy from the Edit menu.  You can also use the 
standard windows command of CTRL+C. 
 
Paste: To paste text into the word processor, place the cursor where you want to 
paste the text and then select paste from the menu.  You can also use the standard 
windows command of CTRL+V 

Highlight 
Scan and Read has a built in highlighter.  When you press CTLR-H or click on 

the  highlight icon.  Whatever text you have selected will be highlighted. 
This is a nice feature if you are studying and need to highlight important parts of a 
document.  There are multiple highlight colors to pick from. 
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Highlight Colors 
 
Scan and Read has 4 different highlight colors to pick from: Yellow, Green, Pink 
and Blue.  The color that has the check mark next to it is the current default.  
Once you have set the default color, it will remain the default color until the next 
time you change it. 
 
You can also change the highlight color by clicking on the color icon on the tool 

bar .  Every time you click on the highlight color button it changes.  The 
color displayed is the color that will be used with the next highlight. 
 

Clear Highlights 
 
If you want to remove the highlights you have added, you must first select the 
area that you want to remove the highlights and the go to the edit menu and select 
clear highlights. This will only remove the highlights from the selected area.  
When you clear the highlights it sets the background color to white. 

Extract 

The powerful feature of “Highlight Extraction”   will search through your 
document and find all the highlighted information and extract it into a new 
document.  You can extract all of the highlighted colors or just one.  This new 
document can be saved or read.  The extraction process retains all formatting, 
fonts and even pictures!  For more information on highlight extraction, see the 
Extracting Highlights later in this manual. 
 

 

Search 
 

To use the Search feature, press CTRL + F or go to the Edit Menu and select 
Search from the Menu.  After doing so, a dialog box will appear allowing the user 
to type in the word they are searching for.  Type in the word and select either 
‘from this point’ or ‘from the beginning’.  If the word is in the document, the 
word will be highlighted and you can make any necessary changes at this point.  
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To continue with your search, continuing pressing CTRL + F until you finish the 
search.  
 

                
 

Lookup Word 
 

Scan and Read Pro has built in dictionary.  You can look a word any time simply 
by double clicking the word you wish to look up, or you can highlight the word 
and press CTRL+L.   
 

 
 
This will open up the definition window which you can then have read to you by 
clicking on the read button. 

 

Spell Check 
 

Scan and Read Pro comes with an integrated talking spell checker. You can 

access the spell check by clicking on the Spell check icon  or select “spell 
checker” from the edit menu.  If you have any word in your document that spell 
checker cannot find in its dictionary, it will prompt you with a suggestion. 
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If you want to hear any word in the list, all you need to do is highlight it and it 
will read the word back to you. 

 
Word In Question:  The “word in question” is the word that the spell checker 
found in the document that it did not recognize.  To have the computer read the 
word to you, select the Read Original button.   

 
Replace With:  Anything typed in the “Replace With” edit box will be used to 
replace the “word in question”.  When you select a word from the list, it will 
appear in the “Replace With” edit box.  To hear what you have typed or selected, 
click on the Read Replace button. 

 
Change:  When you select the Change button, the word in question will be 
replaced with the text that has been entered in the “Replace With” edit box.  It 
will only replace the highlighted word in the document. 

 
Change All:  The change all button will replace all occurrences of the word in 
question with whatever is placed in the “Replace With” edit box. 

 
Ignore: When you select ignore, it will not replace the word in question.  It will 
only skip that occurrence of the word. 
 
Ignore All: The “Ignore All” command will ignore all the occurrences of the 
word in question and will not prompt you each time it finds it. 
 
Cancel:  This will Cancel the spell checking of the document. 
 

Thesaurus  
 
The Scan And Read Pro comes with its own thesaurus.  To use it, simply 
highlight the word that you want to find a synonym for and the select Thesaurus 
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from the edit menu.  It will then open up a dialog box and list the highlighted 
word in the “Looked” field. 
 

 
 
To the right of the Looked field is the Replace field.  Whatever is in the Change 
field will replace the originally highlighted word in the source document if you 
select Replace.  The synonym list will display all the possible words that could be 
used to replace the original.  If you find a word you want to use, simply highlight 
it and click on the Replace button. 

 

Scan Menu 
 
The scan menu contains all the feature needed to acquire an image from the scanner.  
You can also import an image that has already been scanned, or import a PDF file 
directly into Scan and Read Por 
  

Scanning 
 

The Scanning Feature in scan and read will work with any TWAIN compatible 
scanner, including the print, copy, fax, and scan multifunction units.  This utility 
is a very fast method to acquire documents which only exist in the physical world.  
To start the scanning utility, simply open Scan and Read Pro and then select the 

“SCAN” button.   This will start the scan utility.  The scan utility will 
accept whatever the user places directly on the scanner, and then transfer it 
directly into a Scan and Read. 
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There are several things the user will need to verify before scanning is started.  
First, verify the desired document to be scanned is actually on the scanner.  Once 
the document is positioned on the scanner, the user should verify the image 
source.  Lastly, the source should be set to the particular scanner being used. 
 
By default, the “MANUAL SELECT” is set.   Adjacent to the Manual Select, the 
user will see a dropdown list of all the image devices on the computer.  An image 
device can be a digital camera, webcam, or scanner.  Windows does not 
distinguish between the various image devices, and simply lists all available 
devices.  From the dropdown list, verify the device the user wishes to use, is also 
the same device listed in box.  If a device is not listed, go to the scanner 
manufacturer’s website, download and install the TWAIN drivers for the unit.  
Once the user sets the default device, the next time the scan utility is opened, it 
will default back to the last device used.  
 
Pixel Type:  The pixel type should always remain on the true color.  It’s 
recommended, the only occasion the true color should be changed, is when the 
color mode is very slow. 
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DOTS PER INCH: Or more commonly referred to as “DPI”.  The scanner utility 
defaults to 300 DPI.   The 300 DPI is the optimal resolution for PDF Equalizer 
and PDF Magic.  When using a smaller than 300 DPI, the quality of the scans will 
not be detailed enough to be read by the software.  A larger resolution does not 
always improve accuracy, but it can enhance the output for less than good quality 
original documents. 

 
 

Scanner Options 
 

There are four scanner options allowing the user to control the scan process: 
Show TWAIN interface, Clear Image Buffer After Scan, Enable Feeder, and 
Enable Duplex. 
 

 
 
Show TWAIN User Interface:  Each scanner comes with its own interface. This 
is typically different for all scanners.  If this option is enabled when scanning, the 
interface provided by the manufacture will be used.  Since each manufacturer and 
model is slightly different, the Scan utility provides a unified interface for all 
devices. 

 
Clear Image Buffer After Every Scan:  When a document is scanned, the 
scanner will take a picture of what is on the scanner and then hold it in memory, 
until the user saves the document.  This enables the user to preview the image and 
make any necessary changes before it’s saved.  But, if this option is not checked, 
the image in the buffer will not be saved immediately.  Use this option if the 
computer has a limited amount of ram. 
 
Enable Feeder:  The enable feeder is an option that enables the ADF of the 
scanner.  If the user checks this option, and the scanner does not have an ADF, it 
will be ignored.  If the user places a document or object in the ADF, but does not 
have this option checked, your scanner may ignore the ADF as well.  Most 
scanners will use the ADF regardless whether this option is checked or not, even 
if a document is placed in the ADF.  
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Scanning 
 

Once the user has made all the necessary setting changes, he/she is ready to scan.  
Simply place the desired document on the scanner and click the “SCAN” button  

.   
A scanning progress bar will start in a few seconds. 

 

 
 

As the images are acquired, they will be displayed in the view window.  Each 
scan is placed right after another in order.  Once scanning is completed, the user 
can navigate page by page to preview the scans before they are saved.  Any 
undesired scans can be deleted before they are saved to a file.  Once the user has 
previewed the file, they are ready to be saved. 
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Clear Scans 
 

Common errors often occur, such as pages being placed askew on the scanner.  

When this occurs, simply use the “CLEAR SCANS” button. .  Use 
this option for multiple scans.  If the user has an ADF and wants to scan one side 
of the document and then the other side, select “CLEAR SCANS”, and then scan 
the other side of the document into a separate file. 

 
Previewing The Scanned Page 

 
The scanning utility enables you to preview the scans before they are processed. 
The buttons at the bottom of the window let you navigate from page to page.  
 

 
 
And if you get to a page you want to remove just click on the button labeled 
“Delete Current Page.”   This will remove the image allowing you to rescan it.  
Scan and Read Pro does not care if a pages is scanned in upside down or sideways 
it will figure it out and when it is processed it will correct it. 

 
Processing Your Work 
 
Once the user has completed all necessary scans, the work must be processed.  To 

process your work select the process button  on the scanner utility 
screen. This will process the images and convert them to text. There are two 
options to chose from when processing the images. One option will provide you 
with just plain text, and the other is text with images. 
 

 
 
It is important to note that  Scan and Read will put the text in continous reading 
format.  That means that if you have a page with two columns it will convert the 
columns into a single column by placing the right column underneath the left 
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column so that when Scan and Read Reads it will read everything in the right 
order and you will not have to tell it what to read.  If you need the text to remain 
in exactly the orginal format you will want to use the Scan option in PDF 
Equalizer.  PDF Equalizer will keep the page exactly the same as the orginal. 
 
Inserting the Scanned Information 
 
There are two ways to insert the scanned document. You can append to the 
existing document, which is the default, or you can insert at the cursor location.   
 

 
 
Append to Document: This is the default setting.  When this option is selected 
every page you process will be appended to the end of the document. 
 
Insert At Cursor:  Use the insert at cursor to insert the scanned text where your 
cursor is currently located. This can be very useful if you missed a page and want 
to scan it into a specific location in a document. 

 
Closing without processing 

 

Select the close button  if you wish to close the scan utility without 
saving the scanned image. 

.     

PDF Import Wizard 
 

Scan and Read has a built-in PDF Import Wizard.  This wizard will let you easily 
import a PDF file directly into scan and Read software so that its pages can be 
saved in text format that can be read by Scan and Read.. This feature will enable 
you to take books in PDF format such as those downloaded from Google Books 
and convert them to accessible text  in just a few simple steps. Once you have a 

PDF file saved on your computer, select the “Import PDF” button  from 
the toolbar.  This will open up the PDF Import Wizard. 
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When the wizard opens, select the “Select PDF” button. This will open the 
“Select PDF File” window. 

 

 
 

From this window, navigate to the directory where your PDF file is located. 
Select the file and then click the “Open” button.  This will insert the PDF File into 
the preview area on the PDF Import Wizard.  
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The wizard will display the PDF file, and you can navigate the file by pressing the 

buttons just below the preview area .  
You can go to the next page, prior page, first page or last page just by clicking the 
appropriate button.  The current page number is displayed between the prior page 
and next page buttons. 
 
You can process the entire PDF File or just a range of pages if you only want to 
convert a portion of the book. 

 

 
 

The default is to convert the entire book. To convert a portion of the book, select 
the “Specify Pages To Convert” option. Once this option is selected you will be 
able to specify which pages you want to convert. 
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You can also specify if you want text only, which works best for novels and 
documents that don’t have many pictures.  However, if you have pictures in your 
document, you can select the “Text and Graphics” option. 

 

 
 

If you select the “Text and Graphics” option, the wizard will try to extract all of 
the images and put them in the correct place in the text.  Once you have selected 
the pages you want to convert, just select the “Process” button. 
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You will see the pages change as it processes each one.  The wizard process each 
page and put it into the reading area in Scan and Read Pro.  It does not atomically 
save the file.  If  you wish to  save the information yu must select save within scan 
and read and give it a file name. 

 

Reset OCR 
 

If you ever try to scan and you get an error message saying that Scan and Read 
can’t find a file go to the scan menu and select “Reset OCR” if you get a message 
saying the it was successful you will be all set, if you don’t you will need to 
reinstall Scan and Read. 

 
 

Reading a Document 
 
All the commands your need for reading are found under the Reading menu.  If you want 
to change a voice or set different colors, you will want to go to the Settings menu. 
 

Read 
To read a document, press the F6 Key.  When the reader starts, it will begin 
where the current cursor is located.  To make sure your cursor is at the 
beginning of the document, press CTRL+HOME, this will put you at the 
beginning of the document. The system will continue until it reaches the end of 
the document. To stop reading, press the F7 key.  Press the F6 Key to resume 
where you left off. 
 
There are many ways to control the reading.  You can “right click” any where in 
the document and select Read, “right click” again for Stop, or you can click on the 

Read  or Stop  icons in the tool bar. You can also use your arrow keys 
to help you read.  If you use your Up or Down arrow key, it will read the line that 
you have just moved to.  If you just use your Left or Right arrow, it will read the 
character that the cursor just passed over.   Hold down the CTRL key while you 
press the Left or Right arrow key to read one word at a time. 

 

Stop Reading 
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To stop the system from reading, press the F7 key or click ont the stop icon  
in the tool bar .  If you want to continue where you left off, press the F6 Key.  
Some times you will see the cursor jump ahead a few words when you hit stop.  
This is because we buffer the speech so that it does not sound like a bad cell 
phone connection. 

 

Read Selected Text Only 
 

Scan and Read has several other options for reading other than just read and stop. 
If you only want selected text to be read you can select the text you want to read 
then go to the read menu and select the option called “Read Selected Text Only” 
and Scan and  Read will only read what you have selected. 

 

Read line by line 
 

Read line by line is an option that lets individuals read  a line at a time by using 
the up and down arrows. Every time you use your down arrow it will read the line 
your cursor has just moved to. If you go to read menu and see a check in front of 
this option it is turned on and if ther is no check the option is turned off. 

 

Summarize 
 

The built in summarization feature enables individuals to get more out of their 
reading by helping them identify the most important parts of the document they 
are reading. They can extract the summary into a separate document or have it 
highlighted in the orginal. 

 
Creating a Summary of you document 

 
Scan and read has a built in document summarizer feature. This feature allows a 
reader to reduce the contents of the document to its basic essentials. A language 
modeling system is used to do the summary, giving it a higher degree of accuracy 
over the formula driven models used in the summary feature of Microsoft Word.  
Because Premier uses language, modeling the summary will even be effective on 
fiction that does not always have the formal paragraph structure used in non-
fiction writings. 
 
How to summarize a document 
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The summary feature is built into Scan and Read.  Open Scan and Read and the 
either scan or open a document. Once the document is displayed, you will see the 
tool bar. 
 

 
 

Look for the Summ icon on the  Toolbar .  You can select this icon for 
select Summarize from the read menu. This will open up the summarize window. 

 
 

 
 

You have two choices of how you want the summary; you have one or the other 
or both.  They are Place Summary into a separate document, and Highlight 
Summary in the original document. 
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Place Summary into a separate document.  
 
When there is a check in the Place Summary into a separate document, a separate 
document is created and the resulting summary is placed in it.  This summary can 
be saved or read independently of the original document. 

 
Highlight Summary in the original document. 

 
When the Highlight Summary in the original document has a check mark in it, the 
summary sentences will be highlighted in the original document.  When the 
summary is done, you will be able to look at the original document and see 
exactly where the sentences that were pulled into the summary came from. 
 
There are four choices of colors that can be used by the summary. These colors 
are Yellow, Blue, Pink and Green.  These are the same colors used by the 
highlight and extraction feature built into the E-Text Reader. This gives you a big 
advantage over other summary tools because once the summary is done you can 
go through, and add things to the summary, just by selecting the text you want to 
add and then click on the high light color.  To remove text from the summary 
select the highlighted text you want to remove and then select Clear Highlights 
from the Edit menu. 

 
This is the first summary tool that allows you to quickly modify the summary.  If 
you want, you can have the Summary Highlight in one color, and then switch 
colors for your highlight, that way you will be able to easily distinguish what was 
in the original and what was not. Once you are done highlighting and you would 
like to create a separate document that contains just the summary use the Extract 
feature on the Support Toolbar. 

 
Adjusting the summary size 

 
You can control the size of the summary.  For some documents, you can create a 
summary that is only 10 percent of the original document and some you will need 
a larger summary.  Adjusting the size of the summary will take a little practice to 
meet your needs. To help with this you have two options, you can restrict the 
summary to be a percentage of the original document, or it can be a specific 
number of sentences. 
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The default setting is a percentage of the document.  To switch between 
percentages of the document to number of sentences just select the desired radio 
button.  Once you have made your selection, you can adjust your summary size.  
You adjust the summary size simply by moving the slider to the left to make it 
smaller, and to the right to make it larger.  Just below the slider, you will see the 
percentage or the number of sentences that will be included in the document. 
 
When you have made the selections for your summary just select the Summarize 
button and it will start the summary. The summary process is pretty fast it can 
summarize about 10 pages a second, so a 100-page document will take about 10 
seconds. 

 
 
 

Key Echo 
 
This feature allows users to hear the character that they just pressed.  To toggle it 
ON or OFF, click on Key Echo menu item, or select it and press the Enter key.  If 
it is ON then it will be turned OFF, and if it is OFF, it will be turned ON. This 
setting is saved. 

 

Word Repeat  
 

To use this feature select Word Repeat from the Read drop down menu.  This 
feature when selected allows the user to hear the word they just typed.  Example: 
type the word Monkey, then press the space bar.  You will hear the word Monkey.  
To turn this feature OFF, deselect Word Repeat from the Read dropdown menu.  

Reading Options 
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The READING OPTIONS menu item will open up a window that will allow you to make 
a whole host of changes to your reading environment.    Select Reading Options from the 
Read Menu to open the options dialog box 
 

 
 
There are three tabs on the window they are: Screen Settings, Tracking and Highlighting, 
Word View Settings. 
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Screen Settings 

 
On the SCREEN SETTINGS tab, you can change the background color, 
foreground color, set the default zoom level and font size.  You can also set the 
default folder where you would like all your documents to be saved. 

 

 
 
 

Changing Screen Colors 
 

You may prefer to change the foreground and background colors to make reading 
easier. You would do this from the Screen Settings tab.  To change the colors of 
your screen, just select the desired color form the drop down list.  To the right of 
the drop down list you will see the colors change as you make your selection. This 
will give you an idea of what your color choices look like. There are about 36 
different color combinations. 

 
Zoom Factor 

  
You can set a default magnification level.   This default level will be used 
whenever you start Scan and Read .  Once it has been started, you can change it, 
but the next time you start Scan and Read, it will return back to the default. 

 
 

Place all documents here. 
 

You can set the default location for opening and saving documents.  If you set the 
location, every time you click on the SAVE or OPEN, it will look first in this 
folder location.  To set the location, click on the BROWSE button.  A directory 
list will open. 
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Select the drive and the folder you want to be your default location and then click 
OK.  This will set your default path. 

 
 

Tracking And Highlighting 
 

Use the Tracking and Highlight table to set your reading preferences.  These 
features are only noticeable while the Scan and Read is reading to you. 

 

 
 
 

Highlighting 
 

Scan and Read  now supports multiple forms of highlighting.  You can 
have  Scan and Read highlight by “word only”, “word and sentence” and 
by “word and paragraph”.  The highlight colors are selectable to meet your 
visual preference. 
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Highlight By Word 

 
“Highlight by Word” only highlights each individual word that is being 
read.  It will follow along as the document is being read.     

 

 
 

To select Highlight by Word, go to the Read menu and select the menu 
item “Highlight” and then select the sub-menu item Highlight by Word 
and press the Enter key.  If there is a check mark in front of it, that means 
this feature is turned ON. 

 
Highlight by Sentence and Word 

 
Select this option if you want to have the current sentence highlighted as it 
reads to you.  It highlights both the current sentence as well as the word 
that is being read in that sentence.  The Sentence is highlighted in one 
color and the current word is in a contrasting color.  The highlight colors 
can be selected. “See Changing the Highlight Color” later in this section. 

 

 
 
 

Highlight by Paragraph And Word. 
 

If you want to have the current paragraph highlighted with a contrasting 
color of the current word being read, make sure that there is a check mark 
in front of the Highlight by Paragraph and Word Menu option.  You will 
find the highlight options on the Read menu.  The colors of the highlight 
are selectable. 
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Identifying Word Being Read 
 

Scan and Read gives you two methods of identifying the word being read.  
You can have the word “highlighted” or you can have the “color of the 
word change”.   The default is highlight. 

 
Change Word Color 

 
If you would prefer to have the word change color as it is being read 
versus having it being highlighted as it is being read, make sure the 
Change Word Color option is selected.   If you do select this option make 
sure that you select a change color.   If you select black and your text is 
already black you will not be able to see the word color change.  If you 
select the same color as the background, the word will disappear as it is 
being read.   

 
Word Pause  

 
This feature allows users to slow down the reading of the word without 
distorting the word being spoken.  You can increase the time between each 
word. This will allow individuals time to comprehend the word before 
going on to the next word.  It is a great feature for persons learning to read 
or studying a new language.  To use this feature, place a check in the 
“Enable Word Pause” check Box. 
 

Word Pause Setup 
 

If you have enabled Word Pause, you will also want to select a word pause 
length.  This is the length of time between spoken words. The time can be 
adjusted from 0.25 to 3 seconds. 

 
Word View Tab 

 
First of all, what is “word view”?  “Word view” is a visible window that 
remains stationary on your computer screen while the document is being 
read.  Some people have trouble following a moving cursor or rolling text, 
so we made a stationary window that allows the user to focus on a single 
place on the screen for reading.  The word view window will display 
EACH word that is being read.  It is always displayed in the same spot, so 
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you do not need to move your eyes.  It also gives you the ability to change 
the font size, background color and text foreground color independent of 
the document being read.   

 
 

 
 
 

Word View Settings 

 
To change the settings of the Word View window, go to the Read menu 
and select Reading Options, and then select the Word View tab.  From this 
window, you can adjust the font size.  You can select from 8 to 24 point 
font.  When you select a font size, you will see the sample text change to 
reflect the new setting. You can also change the Background Color and the 
Text Color.  You do not need to “save” the changes.  All you have to do is 
select the Close button and the options that you have selected will 
automatically be save for the next time you read. 
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Show Word View 
 

Place a check in the Display View checkbox.  This will display the Word 
View Window while Scan and Read is reading.  Remove the check if you 
want to turn off the Word View settings. 

 

Create Audio Window 
 

Scan and Read can turn your current document into an audio file.  Scan and Read 
can make both MP3 files and Wav files.  It is a great way to take a document way 
from your computer.  For example, turn a chapter of a book into and audio file put 
it on CD and listen to it in your car or on your portable CD player.   

 

MP3 Create 
 
To create an audio file, go to the MP3 menu and select MP3 Create.  It says “MP3 
Create”, but you can create more than just MP3’s. Before you can make an audio 
file, you need to have text loaded into Scan and Read.  You can do this by 
scanning a document, opening up an existing document or pasting it in from 
another document. 
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After the window opens, make the necessary adjustments and then click on the 
Create Button. 
 
Selecting a voice 

 
Scan and Read will work with many different voices.  However, to create audio 
files, you can only use “SAPI 5 compliant” voices. Scan and Read provides you 
with 3 voices from Microsoft: Microsoft Mike, Mary and Sam, and 2 AT&T 
Natural voices Mike and Crystal.  You may have others listed as well.  If you 
select one that asks for a password, you will not be able to use it.  They were 
installed with a program, which only has the right to use it.   Click on the down 
arrow next to the voices list box  and select a voice from 
the list. 
 
 
Rate 
 
You can adjust the speaking rate by moving the slider bar left or right. (Left is 
slower, right is faster).  To hear your changes, click on the Test Voice button 

. 
 
Pitch 

 
You can adjust the voice pitch by moving the pitch slider bar left or right.  (Left 
makes the pitch goes higher; right makes the pitch go lower.  To hear your 
changes, click on the Test Voice button . 

 
File Name 

 
You can type in a file name or select the Browse button .  If you click on the 
browse button, you can select where you want the file to be saved and provide it 
with a name.  The file type selected will determine what extension it will be 
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given.  For more information about the different file types, see File Type this 
section. 
 
File Type 

 
Scan and Read can make two different types of Audio files.   

They are Wave and MP3.   
 
Wave is a standard audio file and can be put on a CD and played with a standard 
CD Player.  MP3 is a format that can be played on any MP3 player.  The MP3 
format generally produces a smaller audio file than a Wave.  The smaller the “Bit 
rates”, the smaller the resulting files.  For more information about “bit rates”, see 
MP3 Options.   
 
MP3 Options 

 
There are seven different bit rate settings for MP3 files. The default is 128.  What 
is a bit rate? It is the number of times an audio signal is sampled per second.  The 
bit rate is measured in thousands.  So a bit rate of 128 means that the audio signal 
is sampled 128,000 times per second.  The less it samples the smaller the audio 
file.  128 are good for music, but for audio that is just “reading text”, you can 
probably use 64 bits and not notice any difference in quality.  The bit rate options 
are only enabled if the Audio File type selected is MP3. 
 
Creating a File 

 
Once you have made all the desired adjustments, you can create the audio file by 
clicking on the  create wave button.  If the audio file type “MP3” is 
selected, this button will say Create MP3.  When the file is done, it will tell you 

“reading is done” in the lower left hand corner of this screen .  If you 
are creating an MP3 file, there is one more process that will occur: the MP3 
compressor.  This process takes the freshly created file and turns it into an MP3 
file. 
 
What size audio file will it create?    If you use the default settings, you will get 
about a 1 minute audio for every 1,000 characters and a minute of audio takes 
about 1 megabyte (MB) of disk space. This is just a rough guideline and it may 
very depending on your settings. 
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Settings Menu 
 
The settings menu is where you fine tune Scan and Read to meet your needs. All the 
adjustments that you make here are saved, so the next time you open Scan and Read, you 
will not have to make the changes again. 
 

Line Spacing 
 

Line Spacing is a feature that allows users to increase/decrease the space between 
each typed line of text.  To increase the space between lines, go to the Settings 
Menu and select Spacing from the menu.  A dialog box will be displayed with a 
drop down box allowing you to select the space between lines of up to 5X the 
original layout.  To change, select the size and then click Apply.  If you like the 
change, select OK.  If you do not like the change, make another selection until 
you find the setting that you want.  To go back to your original setting, select 1X.  
Then press the OK button.  

                           
 

Word Spacing 
 

Word Spacing is a feature that allows users to increase/decrease the amount of 
space between each word.  To increase the space between words, go to the 
Settings Menu and select Spacing from the menu.  A dialog box will be displayed 
with two buttons for Word Spacing.  One for Decrease and one for Increase.  To 
do either, select the appropriate button.  The program will scroll through the 
document quickly and make the necessary changes.  If you like the change, select 
OK.  If you do not like the change, make another selection until you find the 
setting that you want.   Then press the OK button. 
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Page Display 
 

There are two ways to display the information in Scan and Read and they are 
Normal view and Page view.  In Normal view, the edit area fills the entire width 
of the screen, and in Page view, it displays the boundary of the pages. 
 
Normal View 
 

 
 
Page View 
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Voices 
 

The system comes with 21 standard voices.  You can change the voices at any 
time by pressing the F12 key, or you can press ALT+T to bring up the Settings 
menu.  You can then select Voices from the menu (see below). 
 

 
 
You can scroll through the list of voices until you find the one you want.  As you 
select a voice, the voice will be read to you so you can hear what the voice sounds 
like. 
 
Once you have selected the desired voice, you can adjust the rate by moving the 
first slide bar to the right for faster and left for slower.  Simply click on the slide 
bar to make an adjustment.  (You can also use your LEFT ARROW or RIGHT 
ARROW keys to adjust the slide).  Select the RESET to set everything back to the 
default settings.  Both the Rate and Pitch can be adjusted from a –10 to 10, with 0 
being the default, some voices have a  range of 0 to 350 with 180 being the center.  
You only have to set the voice when you want to change.  The system remembers 
your last setting each time you start the system.  Once you find a voice setting that 
you are comfortable with, you will rarely need to change it again. 
 
You adjust the Pitch just like changing the voice rate.  Moving the slider to the 
left will decrease the pitch, sliding it to the right increases the pitch (you can also 
use your LEFT ARROW or RIGHT ARROW keys to adjust the slide).  As both 
the Rate and Pitch are being adjusted, you will hear what the new settings sound 
like. 
 
Select the OK button to close the window and save the changes.  Selecting the 
Cancel button will close the window without saving any of the changes. 
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Zoom 
 

The system is equipped with a Zoom feature.  The Zoom feature allows users to 
Zoom from 25% to 400% of the current font.  The reader will work at any 
magnification level.  The default setting is 100%. To Zoom in or out you must 
select the Settings menu by pressing ALT+T.  Then select Zoom from the menu. 
This will open up the Zoom sub menu.  This menu lists all of the available 
percentages.  Select the one you want and it will change immediately. Or you can 

just Click on the Zoom Icon .  If you continue to click on the icon, it will 
continue to zoom in until your reach the maximum. Once you have reached the 
maximum and you click it again it will go to its smallest setting, allowing you to 
continue to zoom out.  You can also do this by pressing the ESC key. 
checked. 
 

Reset Defaults 
 
If you want to reset the system back to the original settings, use this option.  To 
set the entire Scan and Read application back to the way it was when it was 
installed, press Alt + T to go to the Settings Menu and then select the Reset 
Default option.  This will reset everything except the voice.  It will reset the voice 
rate and pitch, but not the voice. 

 

Default Voice 
 

The default voice setting will load the default voice.  It will not change the rate 
settings nor will it change the voice pitch.  To reset the system back to the default 
voice, press Alt + T to go to the Settings Menu and then select the Default Voice 
option. 
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Help 
 

The Help option provides two ways of getting information. One being the 
traditional help files.  You can get to it by pressing F1.  If you want to see the user 
manual, go to Load User Manual option under this menu.  It loads the manual 
directly into Scan and Read.  You can then have Scan and Read read the entire 
manual to you. 
 

Load User Manual 
 

The user manual is build right into Scan and Read. We do this for two reasons. 
First, you will never have to worry about losing your manual, and second, since 
Scan and Read is a reading tool, we set it up so that Scan and Read can read the 
manual to you. 

 

Hot Key List 
 

For a quick glance of all the hot keys, go to the help menu and select the option 
"hot key list". The hot key list will open. Use your up and down arrow to hear 
each item in the list. 

 

 
 

Help About 
 

The Help About box is a small window that tells you what version number you 
have and contact information.  To open the Help About window, press ALT+H to 
open the Help menu and then select Help About.  To exit this window, press the 
Enter key. 
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Word Prediction  
 

Configuring your word prediction 
 
The Predictor Pro word prediction can be easily configured to best suit your 
needs. You can change the font size of the prediction list, edit the word list and 
even set the minimum number of characters you want to enter before it displays 
the prediction list 
 
Select the options menu item from the Prediction Menu.  This will open up the 
Prediction settings window. 

 

 
 

Word List font size 
 
You have the choice of 3 different font sizes for your prediction list.  Small which 
is the default is 10-point font, medium is 12-point font and large is 14 point.  Just 
select the size you want. 

 

Libraries 
 

The new Predictor Pro comes standard with two libraries.  An Unabridged and an 
Abridged.  The for the most part, both libraries contain the same information, with 
the exception being that most offensive, vulgar and obscene language has been 
removed from the abridged dictionary. 
 
You are not limited to what we provide in the libraries.  You can edit it, add your 
own words and even delete words you do not want. To view the words in the 
library, select the library you want and then select the View Library button. 
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Modifying the Libraries 
 

Select the View Library button from the Prediction Options window to edit the 
word libraries.  This will open up the Edit Word list window.  When it opens, all 
the words will be displayed in alphabetical order.  The abridged and unabridged 
dictionaries contain 80,000 of the most commonly used words.  In addition to 
commonly used words, it also includes over 1,100 commonly misspelled words 
and phonetically spelled words. 
 
Remember the old grammar rule “i” before “e” except after “c”.  Unfortunately, 
that is only good most of the time.  For example, the word “weird”.  Word 
prediction will pick up these misspellings and provide the user with the correct 
word.  The same thing will happen if you phonetically spell “phone” with an 
“f”….”fone”.  Word prediction will detect that as well and offer the correct 
spelling. 

 

 
 

Click To Search 
for a Word 

 
 

 
In the library table view, you will also see a Usage column.  The Usage column is 
how often the word is used in the English language.  The larger the usage number, 
the higher on the prediction list it will appear. 
 
Users can add their own words and even abbreviations to the prediction list.  For 
example, the name of your organization may be quite large “Traverse City 
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Intermediate School District”.  You can enter short hand TCISD and every time 
you type those five letters you could replace it with  “Traverse City Intermediate 
School District”, thereby, saving you a significant amount of typing.  For more 
information on adding a word, see “Adding Words to the Library” section later in 
this section. 

 
 

Show Modified Words Only 
 

There is a checkbox called “Show Modified Words only”.  When this is checked, 
it will only show the words that the users has added or modified.  It gives you a 
quick way to review all your custom words. 

 
 

Commonly Misspelled words. 
 

In addition to the regular library of correctly spelled words, we also provide you 
with a list of commonly misspelled words.  To see this list, just check the check 
box.  If you have words that you often misspelled, you can add them as well. In 
that manner, when you misspell those words, you will be prompted with the 
correct spelling. 

 
 

Display List After 
 

Word prediction will provide users with a floating word list.  As they type, the list 
floats along displaying the predicted words.  The more characters you type, the 
more accurate the predicted words will be.  It is rare that the prediction can 
predict the word you are looking for with just one character.  So that is why we 
give you the option of displaying the word after you have typed a set number of 
characters. The default is 2 characters, but you can make it any value you choose.   

 

Saving Your Word Prediction Settings 
 

When you are done making your adjustments, just select the OK button.  The 
options that you have selected will automatically be saved.   When you open up 
the word prediction options window, it will display your current configuration. 
When you close the window, the changes you have made will now become the 
default configuration. 
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Adding a word to the library. 
 

To add a word to a library, you need to have the dictionary open.  You do this by 
selecting the Options menu item from the prediction menu in Scan And Read Pro.   
Once the options menu is open, select one of the libraries. 
 

 

 

Select a library 

 
And then select the View Library button.  This will open the Edit word list 
window. 

 

 
 

To add a word, just select the Add Button.  When you select the Add button, the 
Add Word window will open. 
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When adding a word you, have two places to type in the word.  You have the Add 
Word edit field.  You enter the correct spelling of the word.  This is the word that 
will be displayed in the prediction list.  The second field is the Alternative 
Spelling.  This field allows you to enter in an alternative spelling for the correctly 
spelled word.  For example, if you constantly misspelled the word “tomorrow” as 
“tomorow” you can enter your alternative spelling and then every time you 
misspelled, it would prompt you with the correct spelling of the word. 

 
The alternative spelling can be used for many different things.  You can use as 
short hand or the phonetic spelling of a word.  For the word “phone” you could 
enter in the alternative spelling “fone” and that way any time someone spelled the 
word phonetically, the correct word would appear in the list. 

 
Word Usage.   Not all words are created equal.  Some words are used more 
frequently than others   For example, the word “antelope” is not used as often as 
the word “anticipate”.  Therefore, if you typed in the letters and you would want 
“anticipate” to be higher on the list than “antelope”.  You can provide a usage 
value to any word you add to a list. 
 

 
 
 
Just move the slider bar from the left to the right.  The default is zero.  The higher 
the value you give a word, the higher it will be displayed on the prediction list. 
Higher value words appear higher on the list that words that have a lower value, 
but similar spelling. 

 
You can use this feature to adjust words already in the library.    If you don’t want 
a word to appear on a list you can completely remove the word form the library, 
or you can give it a usage value so low that it will only display when all other 
options have been exhausted. 
 
When you are done adding a word, just select the OK button. 
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Removing a word from a Library. 
 

To remove a word from a library, you need to first have the library open.  Once 
the library is open, you will then need to find and select the word you want to 
remove.  You can tell what word you are on by the arrow next to the word. 
 
 

 
 

To remove the word, just select the Remove Button. Caution: This is 
permanent.  Once you have removed a word, it is gone forever.   The only way 
you can get it back is to add it back in. 

 
 

Using Word prediction 
 
 

You can use word prediction without having to make any changes to the 
configuration.  Just turn it on and start typing.  If you would like to change the 
prediction settings, go to the Prediction menu and select the Options item. 

 

Turning Word Prediction on or off. 
 
By default Word Prediction is OFF and you need to turn it ON before you start 
using it.  Once it is turned ON, it will remain ON until it is turned OFF again. If 
you have word prediction turned ON, when you exit Scan and Read Pro it will be 
ON next time you use Scan and Read Pro. 
 
To turn ON Word Prediction, go to the Prediction menu in Scan and Read Pro and 
select the Word Prediction Menu option.  You can also press CTRL + W to toggle 
it ON or OFF.  If there is a check mark in front of the menu option, then word 
prediction is turned ON. 
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How do I use word prediction 
 

Once you have word prediction turned on, all you have to do is start typing!   As 
you type, the floating prediction list will appear and follow your cursor as you 
type. 

 

 
 
When the word list is visible, to hear the words in the list, just use your UP and 
DOWN arrow keys to go through the list. . 
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Selecting a Word from the word list 
 

Use your UP and DOWN arrow keys to go up and down the list. As each word is 
highlighted, it will be read to you.  There are three ways to select the word to 
insert into your active document as you are typing.  (1) You can simply double 
click the word with your mouse, (2) Press either CTRL key on your keyboard or 
(3) press the corresponding number in front of the word you want.  In the 
following example, you would press the number 6 to select the word “typing”.   
The numeric keypad will not work for selecting these words.  You must use the 
number keys above the letters on your keyboard. 

 
 

 

Press the # 6 or 
either CTRL 
key to selelect 
the word 

 
 
 

How to get the right word every time 
 

Word prediction is great, but how does one know if they have selected the right 
word?  It is easy Scan and Read Pro.   If you would like to find a definition of a 
word in the prediction word list, just select the word with your mouse and then 
click the right mouse button (once).  When you do that, the definition window 
will open. 
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When the definition appears, just click on the read button to hear it. Or use your 
up and down arrows to read a line at a time.  When your are done, just press the 
ESC key or click CLOSE. 

 

Find the definition of a word any time just by double 
clicking the word. 

 
If you would like to find a definition of a word, you can at any time just by double 
clicking the word in Scan and Read Pro.  When you double click a word, the 
Definition window will open and then all you need to do is click on the READ 
button to hear the definition.  When you are done, click the CLOSE button or 
press the ESC key. 
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Appendix A System Requirements 

 
System Requirements 

 
CPU:   900 MHz Pentium or Faster 
Memory:  256 MB   
Disk space:      400 MB  
CD ROM:  4X or Faster 
Keyboard:   104-key Standard Keyboard 
Mouse:  Standard Mouse 
Speakers:  Standard Speakers 
Sound Card:   Any Windows Compatible Sound card 
Scanner: Any TWAIN compliant, USB compatible scanner 
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